
ASHAMPOO's Monitoring Functions

As you will discover, ASHAMPOO 99 DELUXE gives you a powerful, comprehensive and very 
precise set of functions for monitoring your system configuration. Even the smallest changes 
between two configurations are registered (i.e. before and after installing an application), 
including changed file dates.

All the following items are monitored:

Registry:
Deleted keys
New keys
Deleted values
New values
Changed values

All these changes can be reversed to restore previous system status.

Drives:
Deleted directories
New directories
Deleted files
New files
Changed files (size, date and attributes)

You can delete new files and directories but deleted files cannot be restored unless you have 
made a backup in advance! See File Backup for a discussion of this issue.

Initialization Files:
ASHAMPOO monitors WIN.INI, SYSTEM.INI, CONFIG.SYS and AUTOEXEC.BAT for all these 

items:
Deleted entries
New entries
Deleted values
New values
changed Values

All changes in WIN.INI and SYSTEM.INI can be reversed to restore previous system status. 
Unfortunately, this is not possible for text files like AUTOEXEC.BAT and CONFIG.SYS; these 
files must be restored manually.

You can also add user-defined system files to the list for monitoring. See User-defined System 
Files.



Batch Commands

You can also run ASHAMPOO 99 DELUXE in batch mode from the command line:

Command line parameters:

/STORECONFIG

Saves the current computer configuration. This is equivalent to performing the following steps:

1. Start ASHAMPOO 99 DELUXE.

2. Action / Save Current Configuration OR 

3. Exit ASHAMPOO 99 DELUXE.

/COMPARE filename

Generates a comparison log file with the name filename. This is equivalent to performing the 
following steps:

1. Start ASHAMPOO 99 DELUXE.

2. Action / Compare (create log file) OR 

3. Exit ASHAMPOO DELUXE.
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ASHAMPOO 99 DELUXE is a powerful application deinstallation tool. It can monitor and 
register virtually all changes made to your system by installation programs, enabling you 
remove applications very thoroughly. 

ASHAMPOO 99 DELUXE is designed for Windows® 95, 98 and NT 4/5 and has been tested 
extensively on all these systems. It is particularly effective at monitoring and handling changes 
to the Windows registry. This means that with ASHAMPOO 99 DELUXE, your registry will no 
longer be a bottomless pit full of data garbage!

Important Warning:
THIS PROGRAM DELETES FILES AND SYSTEM CONFIGURATION ENTRIES!
It is not recommended for beginners and novice users! 

If used improperly ASHAMPOO can cause serious damage to your system configuration! 
Please make absolutely sure that you really know what you're doing before you allow the 
program to delete anything!
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Default Selections

The first time you start ASHAMPOO 99 DELUXE it displays a set of default selections that are 
quite effective for most purposes. If you want to monitor other sections as well you must select 
them manually. You can always reset the selections to these default values by selecting Reset 
Selections in the File menu.

NOTE: The default settings automatically exclude the HKEY_LOCAL_MACHINE\ System\ 
ControlSet00x branches. These branches are copies of    ...\CurrentControlSet that are 
sometimes generated and renamed when Windows reboots. (In Windows NT this is the "last 
known good configuration"). Monitoring these branches doesn't usually serve any useful 
purpose and selecting the branches manually is not recommended. Whatever else you do, 
please don't delete or modify any of the settings under HKEY_LOCAL_MACHINE\ System\ 
ControlSet00x as this will crash your system. In some cases you may not even be able to reboot
afterwards!

ASHAMPOO 99 DELUXE doesn't normally report any changes in these branches. This makes it
possible for ASHAMPOO to handle system crashes during installation routines without any 
problems, as these entries are normally written by Windows after crashes.

If you need to monitor the contents of these entries you can select HKEY_LOCAL_MACHINE\ 
System\CurrentControlSet instead. (This is also included in the default selections.)



Delete Fonts

This function displays all the fonts currently installed on your system and allows you to delete 
them.

The installed fonts are displayed alphabetically in the list on the left. The windows on the right 
show you what the font looks like and display additional information on the font (TrueType only). 

The text in the sample window is editable. If you would prefer to have another text just enter it in
the window and it will be stored automatically as the new default when you exit.

Deleting fonts is actually pretty intuitive: Just select one or more fonts and click on Delete 
Fonts.



Dual-boot Windows NT / 9x Systems 

If you have a dual-boot system running both Windows NT and Windows 95 or 98 it is advisable 
to install ASHAMPOO 99 DELUXE in separate folders under each operating system. Otherwise,
ASHAMPOO will become confused because the contents of the config and log files created 
under one system will not match the current structure of the registry. You will also get completely
meaningless results if you inadvertently try to compare the configurations of two different 
systems, which can happen if you are running ASHAMPOO from the same folder under both 
systems.

This is all the more important on systems with Windows 95/98 and Windows NT installed on the 
same partition, which is quite possible on FAT16 drives. On such systems you have to take 
particular care to only select items and folders belonging to the relevant operating system. 

Since dual-boot systems are normally only used by experienced users we assume that you 
know what you are doing and understand the issues involved here!



Exporting and Printing Log File Data

You can export all the monitoring data stored in your log files to plain text files for archival and 
printing. 

Just right-click on an item or tree in any of the View Log File tabs and select Export Data to 
write that item's data to a text file that you can edit and print with Notepad or a word processor.

Note: A brief explanation of the entries is inserted as a header at the beginning of each export 
file.



File Backup

Usually, ASHAMPOO 99 DELUXE only monitors files, i.e. it simply watches and records what 
happens to them. If a file is deleted or overwritten this is recorded in the log file but you can't 
restore the deleted or overwritten file. The problem is there's no way of knowing in advance 
which files will be deleted or overwritten, and to provide restore functionality it would be 
necessary to back up the entire hard disk. As you can imagine, this isn't really a very practical 
option.

However, there are some files that are so important for the system that it makes sense to back 
them up by default, as insurance just in case an application deletes or overwrites them -- for 
example the vital system files located in ..\Windows\System32.

You can specify the folders you want ASHAMPOO to back up in the File Backup dialog shown 
above. Select New Entry, then enter your search criteria in the dialog displayed. In addition to 
specifying the folders you can also enter a search text using wildcard characters to include only 
files from the defined folders conforming to the criteria defined in your search text.

Then select Back Up Files to start the backup. All the files conforming to your criteria will then 
be copied to the backup folder.

If any of these files is then deleted or overwritten by an installation you can restore it 
from the backup folder.

Note:
You can set the backup folder in Settings. See Preferences for full details.



Find and Delete Duplicates

ASHAMPOO 99 DELUXE can also detect and delete redundant duplicate files on your system. 
The search algorithm is very fast -- ASHAMPOO can easily process 50,000 files in 3,000 folders
on 5 hard disks in just a few seconds.

Procedure:

1. Select the drives or folders you want to search for duplicates by clicking in the appropriate 
check boxes in the left-hand window.

2. Select the search type: 
a) Name, Size, Content (very accurate) or 
b) Name, Size, Date (very fast).

Method a) identifies files as identical if their name and content (including size) are the 
same. This method is very accurate but it can take a while because the program has to 
scan all the files from beginning to end.

Method b) identifies files as identical if their name, size and date are the same. This method
is very fast and perfectly adequate in most cases.

3. Select Start Search to start the search. ASHAMPOO first scans and sorts all the filenames 
in the selected locations. Then it searches for files with the same name, after which it 
compares the individual files to check whether they are identical or not.



4. The results are displayed in the two windows on the right. Clicking on a filename in the 
upper window displays the paths of the duplicate files with this name in the lower window.

5. Right-click on the file you want to delete to display the deletion menu. You can also select 
and delete multiple files.

Notes: 
You can sort the list by double-clicking on the column headers in the upper right window (same 
functionality as in Windows Explorer). This makes it very easy to see where the most space is 
being wasted.

You can also use the keyboard shortcuts Alt+A (select all) and Del (delete) in the lower window.



Find and Delete Temporary Files

This function enables you to detect and delete all temporary files stored on your system in one 
simple procedure. 

Search performance is very accurate because you can define your own multiple search criteria 
telling ASHAMPOO exactly what you want to search for and where you want to search. These 
criteria are stored as defaults and displayed automatically every time you select the function.

The first time you select the function the only default entry is the standard Windows TEMP 
folder. To add other items just click on New Entry:

The above example will find files with the tmp extension (*.TMP) on drive C:, including the root 
and all subfolders.

Here are a few more examples of possible search entries:



When the search is complete (Start Search) ASHAMPOO displays all the files that match your 
search criteria. Click on the entries in the upper window to display the items found for each 
search entry in the lower window. You can then right-click on items in the lower window to 
display the deletion menu.

Notes: 
You can sort the list by double-clicking on the column headers in the upper right window (same 
functionality as in Windows Explorer). This makes it very easy to see where the most space is 
being wasted.

You can also use the keyboard shortcuts Alt+A (select all) and Del (delete) in the lower window.



Getting Started

ASHAMPOO 99 DELUXE is a very user-friendly program designed to be as easy as possible to 
use.

This version of ASHAMPOO 99 DELUXE includes an easy new "two-button" system providing 
direct access to the main procedures performed by the program. It is advisable to use this 
system at first until you have learned the basic principles underlying the program. (See Quick 
Two-Button Operation for details.)

If you want you can follow this introduction with the help of the Step-by-Step Wizard , which 
will guide you through all the procedures described below.

The ASHAMPOO 99 DELUXE workplace is divided into two main windows (see The Two 
Program Windows)

1. The first step is to choose the items you want ASHAMPOO to monitor in the left window 
(see Selecting ). The default selections are a good choice for most purposes. When you 
exit the program the selections made are saved and reloaded automatically the next time 
you start. The first time you use the program this is done automatically. After this you will be
asked whether you want to save your selections every time you exit the program. 

2. Next you need to store a "snapshot" of your computer's current configuration with . This 
enables ASHAMPOO to register the changes made when you install new software. This 
means that you should always do this before installing a new application or making 
changes to your system configuration (ASHAMPOO can also be used as a "rescue system"
to recover from unwise configuration modifications). ASHAMPOO needs this configuration 
log to be able to detect the changes made by the installation program.

3. You can then install a new application or edit your Windows configuration. ASHAMPOO 
doesn't have to be running while you do this! Once you have stored your configuration 
snapshot you can exit ASHAMPOO and even reboot your computer if you want.

4. Then restart ASHAMPOO and select  to store an image of the new configuration and 
compare it with the previous one recording the system state before the installation (see 2. 
above). Clicking this button accesses both the store and compare functions. You will be 
asked to specify a filename for the comparison.

We generally recommend performing this step directly after installing a new application, as 
this keeps the list of changes short and ensures that only the changes really made by the 
application program are included. You can even perform the comparison a week later if you
want, but then the list of changes found can get very long and its contents are less 
meaningful.

Note: Many applications write their final configuration information the first time you run them 
and not during the installation process. This means that it's always a good idea to run your new 
application at least once before performing the comparison. See Running Applications after 
Installation.



5. All the changes found are then displayed on the screen (switch to the View Log File tab if it
is not displayed automatically):

If you want to restore original values or delete a file or folder just right-click on items in the right 
window or tree elements in the left window. You can select multiple items in the right window. 
ASHAMPOO then displays a pop-up menu. Select Restore Changes in this menu to display 
the following screen listing all available restore operations. (ASHAMPOO always displays a list 
of all the actions to be performed before actually performing an operation.)



This window shows a detailed list of all the actions ASHAMPOO can perform to remove the 
application and restore your original system status. 

You can also choose individual items or single groups of operations -- for example if you want 
you can just restore the changed keys/values (check box).

After checking everything and making your choices click on Execute to restore your old 
configuration.

The status of each operation is displayed on the screen so that you can confirm that the restore 
has been performed correctly.

You can get much quicker results by clicking the Restore All button . However, this option 
should be used with extreme caution as it automatically restores all changes! After a prompt 
with which you can select categories the list box shown above is displayed. When you select 
Execute, all changes in the selected categories will be restored automatically -- you cannot 
make any other selections.

WARNING: Restoring changes blindly without checking first can cause system crashes or other 
problems. Please only use this function if you're really sure you know what you're doing. You 
have been warned! 

That's it. Easy, isn't it?



Introduction

In addition to the instructions for using the program this help file also explains the basic 
concepts underlying the program. Some of these explanations may seem a little complex and 
tortuous at first -- this is due to the nature of the material. Deinstalling Windows applications fully
and cleanly is a complex process that can't be described in a few sentences. Please bear with 
me, I think you'll find that it's worth it. When you're through, you'll also find that you have a much
better understanding of how your Windows system works.

You're probably aware that other deinstallers offer "one-click" application removal. All you have 
to do is select the application, click a button and that's it. However, you probably also know 
where this "one-click" approach leads and the problems it can cause.

This program is different. ASHAMPOO 99 DELUXE tells you exactly what it's doing and gives 
you full access to all the information about what's going on in your system. You can also click on
a "Remove All" button if you want, but you do so knowing exactly what you are doing and what 
the consequences can be.

Unlike other deinstallation products ASHAMPOO doesn't promise to perform miracles. It shows 
you what's going on, tells you what's possible -- and what's not -- and gives you the tools to do 
what's possible. 

I want to give you a look behind the scenes so that you can understand how deinstallation 
works, what's possible and what's not possible.

Bernd Klaiber
(The Author)



Menu Commands

This section only contains detailed descriptions of the menu commands not included in the 
toolbar. For full details on the commands included both in the toolbar and the menus 
(commands shown below with icons) please see Toolbar Commands. Some of the more 
complex commands are also discussed in detail in separate topics (just click on the links to see 
these topics).

File Menu

Load Selection: 

Save Selection: 

Reset Selections: 
Resets all selections to ASHAMPOO's default values. Your current selections are normally 
saved in LAST.ECS when you exit the program and restored automatically the next time you 
start. See Default Selections.

Restore Saved Config File:
It's possible to delete the config file accidentally if you execute Store Current Configuration 
instead of Compare after installing an application. If this happens you can still recover the old 
config file with this command and perform the compare to create the log file.

Wizards Menu

Start Wizard: 

Install an Application: 

Remove an Application: 

Restore All:  (Careful with that axe Eugene!)

Action Menu
Save Current Configuration: 

Compare (create logfile): 

Incremental Compare: 

Find and Delete Duplicates: See Find and Delete Duplicates

Find and Delete Temporary Files: See Find and Delete Temporary Files



Backup Files: See Backup Files

Delete Fonts: See Delete Fonts

Delete Existing Applications: See Delete Existing Applications

Advanced / Save Configuration As:
This is a powerful function designed for advanced users. Normally, ASHAMPOO automatically 
stores your current computer configuration in the file OldCfg.ECD and the configuration used for
comparison after installing an application in NewCfg.ECD. Together with Compare 
Configurations this command enables you to save your entire computer configuration in a file 
of your own choice and compare it with another configuration from a much later date.

Advanced / Compare Configurations:
Use this command to compare any two configurations saved with Save Configuration As. This 
makes it possible to monitor and review changes to your system over very long periods. This is 
very useful for troubleshooting and maintaining a fully functional system. For example, it's 
always a good idea to save a configuration when everything in the system is working perfectly. 
Then if you encounter difficulties -- for example if your e-mail system suddenly stops working 
properly -- you can save a new configuration and compare the two to localize and correct the 
cause.

Refresh View: 

Help Menu
Help: Activates this online help system (also available with F1)

About: Displays the ASHAMPOO version number and copyright information.

Register: Displays the dialog for entering the registration key you receive when you register the
program.



New Features in ASHAMPOO 99 DELUXE

Even though the DELUXE edition of ASHAMPOO is the first version published in English (this 
was originally a German program) you may still find it interesting to know just how many 
features we've added since the last German release:

Correct handling of Shared DLLs:
Faster registry and file compare for log file generation (particularly with larger numbers 

of selected items)
Bugfix: When restoring empty registry entries ASHAMPOO now writes a null string 

instead of '(empty)'.
Restored log file items are now displayed grayed and they are only restored once, even 

if you choose the same item twice.
An error message is now displayed when you attempt to delete non-existent registry 

items. 
Recursive handling of subfolders in the log file now works much better.
New automatic check to prevent selection of duplicate registry keys (e.g. 

HKEY_CURRENT_USER and HKEY_USERS, which often contain duplicate entries). See 
Selection Issues for more details on this.

No more errors in HKEY_DYN_DATA (CreativeLabs bug, Win95/98 only).
The irritating save prompt displayed when you exit ASHAMPOO 99 DELUXE now only 

appears if you really have made changes to the selection.
ShellExecute for files in the selection and results windows (open/execute files with 

double-click).
Accidentally overwritten config files can now be restored (see Menu Commands).
System DLLs are now backed up automatically and can restored after deletion or 

replacement (see File Backup).
You can now also view and delete installed fonts (see Delete Fonts).
Implementation of MultiThreading has drastically reduced the time taken to store 

configuration data, actually halving the time required to store the configuration under optimal 
conditions.

ASHAMPOO 99 DELUXE can now also help you to efficiently delete existing 
applications for which you do not have an ASHAMPOO installation log (see Removing Existing 
Applications).

New wizard that gives you direct access to the main functions of ASHAMPOO 99 
DELUXE, guiding you through the procedures one step at a time. 

Welcome Screen (not really earth-shaking, but kind of nice all the same).

We plan to continue improving ASHAMPOO 99 DELUXE to make it even better and more 
powerful. Please help us by sending us tips, bug reports, criticism and praise (this helps to 
motivate us) to the e-mail address listed in Troubleshooting and Support. Also, please support 
the shareware concept and register this program so that we can continue to develop new 
features for you in the future. 



Note for Windows NT Users

ASHAMPOO 99 DELUXE is fully functional under Windows NT. It has been tested thoroughly 
under Windows NT 4.0. It should also work under NT 3.51 but it hasn't been tested under this 
system.

It's important to remember that NT's enhanced security features also apply to the registry. This 
means that    NT may occasionally refuse to allow you to restore a registry entry with 
ASHAMPOO because you don't have the necessary permissions for the required operations.

This problem can usually be solved by logging in as ADMINISTRATOR before running 
ASHAMPOO. 



Preferences

There are two options sections in ASHAMPOO 99 DELUXE. The first is the Options / Icons 
sub-tab in the Selection: Registry, Drives tab:

Options / Icons Tab

This section enables you to specify individual files that you don't want ASHAMPOO to monitor. 
This is needed because the selection options only allow you to select or deselect entire folders 
and directory trees. 

For example, although you will usually want to monitor your Windows directory there are some 
files that are changed very often by Windows, such as the Windows swap file WIN386.SWP or 
PAGEFILE.SYS, and it's a good idea to exclude these as monitoring them doesn't make any 
sense. Just click on the Add button and select the files you want to exclude.

You can also add files to the Excluded Files list by right-clicking on the filename in the Drive 
Selection tab window and clicking on the option in the pop-up menu. Use this method for 
adding large numbers of files at the same time or if you encounter problems with the Add button
in the Options tab (Windows will sometimes refuse to allow you to add files with the Add button 
if they are currently in use).

IMPORTANT NOTE: 
The Excluded Files list is always saved automatically together with the log file when you perform
a Compare. This also means that loading a log file overwrites the current list with the list used 
to generate the log file -- please remember this when loading log files! 

For the same reason it's generally a good idea not to save your current selections every time 
you exit ASHAMPOO; it's better to only save selections that include those things that you 
always want to monitor and/or exclude!

Settings



The second options section is Settings in the Options menu. Selecting this command displays 
the following dialog box, which contains options with which you can adjust a number of the basic
settings in ASHAMPOO 99 DELUXE to suit your personal needs and preferences.

General
Path to your autoexec.bat and config.sys files if they are not stored in the default location (C:\ ).
Strings to be displayed for standard keys and empty keys in the Windows registry. 

Display 
Options for changing the colors of some display elements. These changes are purely cosmetic 
and don't really serve any practical purpose. You can also activate or deactivate the tooltips 
displayed when you position the mouse pointer over elements on the screen.

Delete
These options control the way the program deletes files and shared DLLs. Unlike the last tab, 
the choices you make here can have very serious consequences. Please consider what you are
doing carefully before changing anything here!

You can choose to move deleted files to the Recycle Bin (default) or store them in a separate 
directory, for example on another drive or partition. ASHAMPOO then moves the files it deletes 
to the specified location. If you choose a directory ASHAMPOO will recreate the subdirectory 
structure of the deleted files within the target directory, using the name of the active log file as 
the root.

Example:
Backup folder: 'C:\ASHAMPOO 99 DELUXE'
Active log file: 'aol_access.ecl'
File to delete: 'C:\windows\test.dll'
File is moved to: 'C:\ASHAMPOO 99 DELUXE\aol_access\C\windows\test.dll'



Warning: If you uncheck both these options ASHAMPOO will simply delete the files without 
creating a backup in the Recycle Bin or a backup directory!

Shared DLLs:
This section enables you to specify how ASHAMPOO handles shared DLLs. See Shared DLLs 
for a detailed discussion of this topic.

Backup
This tab contains the options for for the File Backup function in the Action menu. If you check 
Automatically store folders in folder: the files selected in File Backup will be backed up 
automatically every time you select Save Current Configuration. You can also specify the 
folder to be used for these backups. If you are using Windows NT it is advisable to use a 
compressed folder for this.

If you check Restore from backup files ASHAMPOO will try to restore from these backup files.
See File Backupfor more details on this topic.

Notes: 
All these settings are automatically saved as defaults when you select OK to exit the dialog. 
Window sizes, toolbar positions etc. are all saved automatically every time you exit ASHAMPOO
and reloaded when you restart the program.



Quick Two-Button Operation

In addition to giving you full, hands-on access to all deinstallation options and tools, 
ASHAMPOO 99 DELUXE also provides a simplified two-button operation concept for the two 
basic tasks you will want to perform:

Install an Application

Clicking on this button starts the installation Wizard that guides you through the steps of 
installing a new application with an installation log that will enable you to remove it completely 
later if necessary. 

There are four steps in this process. Each step is represented by one tab in the Wizard window.

1. The first step is to select the items you want ASHAMPOO to monitor. The default selections
made by the program when you first start it are good for most purposes. You can restore 
these defaults now by clicking on the Automatic Selection button. (The same defaults can 
also be restored with Reset Selections in the File menu.)

If you want to change the defaults -- for example if you're not installing your application on 
drive C: or for other reasons -- click on Select Manually to switch to the main ASHAMPOO 
window. Make your changes, then click on the light bulb icon in the toolbar or the Install an 
Application button to return to the Wizard. 

2. The next step is to save your current configuration to a config file, which will be used later 
to identify the changes made to your system by installing the application. Click on Next to 
switch to the Save Configuration tab, then click on the Save Configuration button to store 
your current configuration in the config file.

3. You can then switch to the Windows Explorer to install your new application. To do this, 
either click on Switch to Explorer or exit ASHAMPOO and start the Explorer yourself. 
ASHAMPOO doesn't need to be running while you are installing the application -- you can 
even reboot the computer first if you want!

IMPORTANT: After installing your new application please remember to run it at least once 
before returning to ASHAMPOO to generate the log file (see Running Applications after 
Installation for details).

4. After installing your new application and running it once, close the application and restart 
ASHAMPOO. Click on the light bulb icon or the Install an Application button to restart the 
Wizard, then select the Create Log File tab if it isn't already displayed. 

Click on the Create Log File button to store the new configuration and compare it to the 
one stored before installing the application. You will be asked to enter a name for the log 
file -- it's a good idea to use the application name to make the file easier to find later. 

If you want you can also perform this comparison later. However, it's actually best to do it 



immediately after installing an application and running it once, otherwise there's no way of 
knowing which program is responsible for all the changes found. Also, the longer you wait the 
longer the list of changes will get, and going through it to find the changes made by the 
application can be very tedious.

The changes found will now be displayed automatically in the View Log File tabs in the main 
ASHAMPOO window. You can now exit ASHAMPOO -- you don't need to save the changes 
information manually, it is all stored in the log file automatically.

The above steps in the Wizard are the same as performing the following manual operations:

1.  or Action / Save Current Configuration to save the current configuration to a config file.

2. Install the new application.

3.  or Action / Compare (create log file) to compare and generate the log file.

Remove an Application
Select this button to start the Wizard for removing an application. 

In the first tab click on Load Log File and select the log file created after installing the 
application you want to remove (using the procedure described above). 

After loading the log file click on Next to switch to the Restore Previous Configuration tab. 
You now have two options:

1. Semi-Automatic Deinstallation: This is the recommended option. Clicking on this button 
switches to the View Log File tabs in the main program window, where you can review the 
entries and decide which items you wish to delete/restore.

2. Automatic Deinstallation: Use this option at your own risk! Selecting this button will 
restore all changes recorded in the log file and may delete items you would actually prefer 
to keep. Only choose Automatic Deinstallation if you are really sure you know what 
you're doing. You have been warned!

These steps are equivalent to performing the following manual operations in the main program 
window:

1.  or File / Load Log File to load the log file stored for the application you want to remove.

2.  or Wizards / Restore All to remove all changes recorded in the log file.

Selecting the No Log File button starts the wizard for removing applications not monitored with 
ASHAMPOO 99 DELUXE. Please see Removing Existing Applications for details.



Quick-starting ASHAMPOO 99 DELUXE

You can quick-start ASHAMPOO 99 DELUXE by double-clicking on a selection file (*.ECS) or a 
log file (*.ECL) in the Windows Explorer. The file you click on will then be loaded automatically 
when ASHAMPOO is executed. 



Removing Existing Applications 

ASHAMPOO 99 DELUXE can also help you to remove existing applications from your system --
i.e. applications installed before ASHAMPOO 99 DELUXE, for which you don't have an 
installation log.

Although ASHAMPOO 99 DELUXE delivers excellent performance here -- provided you know 
what you're doing -- we have to point out that it is possible that not all parts of applications 
removed in this way will be deleted. There are simply too many places where programs can 
park parts of themselves and their settings. If you try to get a 100% removal rate without a log 
you run the risk of doing more damage than good, and we prefer to err on the side of caution. All
we can do is look and delete in the usual places and hope we got 'em all.

After long and careful consideration we have opted for a semi-automatic approach that lets you 
see and choose the items to be deleted. We could have made it fully automatic but this would 
have been too risky -- it would be much too easy to delete files that your system still needs.

In a step-by-step process ASHAMPOO guides you to all the places where parts of applications 
are normally found. You can then select the items you want to delete, supported by suggestions 
from ASHAMPOO. At the end of the process a summary is displayed so that you can review 
your choices before actually performing the deletions.

Important Warning:
This ASHAMPOO 99 DELUXE module is designed for advanced users and assumes that you 
know what you're doing! The functions provided here give you direct access to your application 
and system files. This means that if you're not careful it's quite easy to delete files that are still 
needed by the system or applications. 

Use at your own risk -- we cannot provide support for problems or errors caused by use 
of this module! 

YOU HAVE BEEN WARNED!



Restored Entries

Entries that have already been restored are displayed with their icons grayed out, like this:

In this example the two lower entries have been already restored (grayed icons). Normally, 
grayed entries are automatically skipped when you perform a restore, even if they are selected.

If you want to restore such items you must select the check box in front of Restore restored 
items again in the Confirm Restore window that is displayed when you select Restore 
Changes in the pop-up menu.



Running Applications after Installation

After installing a new application you should always run it at least once before restarting or 
returning to ASHAMPOO 99 DELUXE. The reason for this is that many programs do not 
perform all their configuration work during installation -- many important settings and options are
only written the first time the program is run. Running the program once makes it possible for 
ASHAMPOO to log these changes as well, which can improve deinstallation performance when 
you remove the application later.

Once you have run the application and performed any necessary configuration work you can 
return to ASHAMPOO and select Compare to generate the log file.

Important Note: 
Playing around with all the functions of a new program is often absorbing and fascinating. 
However, please don't forget to return to ASHAMPOO 99 DELUXE to create the log file after 
exiting the new application! If you don't generate a log file before making any other changes to 
your system you won't be able to deinstall the application properly later.



Selecting

The first step is to select the drives and/or individual items you want to monitor. To select or 
deselect items simply click in the check boxes to the left of the item names in the left-hand 
program window. Selected items are identified by checks in the check boxes.

Note:
Selections made in the Selections: tabs apply both for configuration saving and for 
comparisons (generating log files). However, it's important to understand that when you select 
Save Current Configuration ASHAMPOO only saves configuration information for drives, 
registry trees etc. containing at least one selected item (indicated by a grayed check box) -- but 
it then saves all the information for that drive or tree. 

This means that you cannot add items from a drive or tree that was not selected between saving
your configuration and making a comparison -- or rather, you can, but there will be no data to 
compare it with in the config file. For optimum performance, don't change your selections 
between saving your configuration and comparing.

For additional information on this subject please see Selection Issues , Default Selections and 
User-defined System Files.

'Don't Check Next Time'
After you have performed a comparison you can quickly exclude sections and items from the 
next check by selecting Don't Check Next Time in the pop-up menu that appears when you 
right-click on objects in the View Log tab windows. It's a good idea to use this function to 
exclude keys like HKey_Current_User\ Software\ Microsoft\ Windows\ CurrentVersion\ Explorer\
RecentDocs as these changes are caused by Windows itself, not by the installed application.



Selection Issues

ASHAMPOO 99 DELUXE allows you to selectively define the sections of your system 
configuration that you want to monitor for changes. 

This makes ASHAMPOO very powerful, but it also means that you have to know what you are 
doing. If you don't select any items ASHAMPOO won't report any changes. It's that simple.

Hint:    Try holding down the Ctrl key when expanding or collapsing registry branches. This 
expands and collapses the tree recursively, including all sub-branches of the item you are 
clicking on along with their sub-branches and so on. This is very useful in the View Log tabs but
it can take quite a while in the Selection tabs, particularly if you use it to expand the entire 
registry!

Notes:
It's normally a bad idea to try to monitor both HKEY_USERS and HKEY_CURRENT_USER at 
the same time. When programs change the registry in the HKEY_CURRENT_USER section the
same changes are always performed automatically in HKEY_USERS\'active user'. If 
ASHAMPOO then tries to change both changes, which it will do if you monitor both sections, 
this can lead to unexpected effects because of the mutual interaction between the two sections.

Because of issues like this you should always select the critical branches and review the 
changes that the program plans to make before executing them. If you right-click on the 
root to remove all changes you may experience strange and undesirable effects like that 
described in the scenario above!



Shared DLLs

Most Windows programs use "shared DLLs". These are binary files with the extension .dll, 
which stands for Dynamic Link Library. They are used to store program code for functions that 
can be accessed and used by several programs.

Here's an example of how this works in practice, and what this means for application installation
and removal:

Application A uses a generic sound function file called DSound.dll, which it copies to your 
Windows directory when it installs itself to your hard disk. So far so good: one program, one 
DLL.

Then you install another application, application B, which also uses DSound.dll. Application B's 
install routine looks in the Windows directory and finds that the file already exists. After checking
that this file is the latest version the install routine skips the file, since it is already present.

OK, but now you have two applications using one DLL. What happens if you want to remove 
one of them? Windows handles this problem by storing a registry entry for each DLL with a 
counter that records how many applications are using the DLL. Every time a new application 
that accesses the same DLL is installed the counter is incremented by one. When one of the 
applications is removed the counter is (hopefully!) decremented by one. When the counter 
reaches zero this means that no more applications are using the DLL and it can be deleted.

How ASHAMPOO 99 DELUXE handles shared DLLs:

1. When you restore the Windows registry using the log file created when you installed the 
application the counter of the shared DLL is not restored to the previous value, because 
you may have installed other applications using the same DLL in the meantime. Instead, 
the counter is decremented by the same value it was incremented by when the application 
was installed. If this sets the counter to zero a prompt is displayed asking whether you want
to delete the file: 

You can configure ASHAMPOO's default handling of shared DLLs with Settings in the Options 
menu. See Preferences for full details.



2. If you try to delete a file (using a log file) whose counter was incremented by the same log 
file the following dialog will be displayed:

This warning won't appear if the file's access counter has already been decremented. Then the 
file is skipped (i.e. not deleted) automatically and a message is displayed in the log    window 
when the operation is finished.

Summary:
Handling shared DLLs is a bit complicated but ASHAMPOO 99 DELUXE takes most of the work
out of it. The defaults are safe, making sure that DLLs still needed by the system are not 
deleted.

IMPORTANT WARNING:
NEVER try to use both an application's own uninstall routine (see What About Applications' 
Own Deinstallers?) and ASHAMPOO 99 DELUXE together! If you do they will both decrement 
the shared DLL access counters, which will result in incorrect counter values and may lead to 
the deletion of DLLs that are still needed by the system!

Note:
Like so many things that are a good idea in theory, the DLL access counter mechanism 
sometimes doesn't work all that well in practice. There are two basic problems: Some 
installation routines don't bother to increment the counters, and other installation routines 
increment the counters again and again if you install the application more than once. As you can
imagine, the result can be counter values that are not really very meaningful.

If in doubt, it's always best to keep DLLs rather than deleting them. After all, hard disk space is 
very cheap nowadays!



Take ASHAMPOO for a Test Drive

Follow these instructions to take ASHAMPOO 99 DELUXE for a test drive and see its powerful 
functions in action:

1. Start ASHAMPOO 99 DELUXE and select the items you want to monitor in the Selection: 
Registry, Drives tabs. If you want you can select Reset Selections in the File menu to set
the selections to the system defaults. However, don't forget to include the drive(s) you want 
to use for installing your application -- only C: is selected by default! 
Then select Store Current Configuration in the Action menu or click on .

2. Exit ASHAMPOO and install a large application on your computer (something really 
extensive, like Office 97 or a graphics suite).

Important note: This must be the first time you are installing this software on this 
computer! Please don't try to use this method for reinstalling an application over an 
existing installation.

Then start the application at least once and perform any configuration work required. See 
Running Applications after Installation for details on the reason for this.

3. Exit the application, return to or restart ASHAMPOO and generate a log file by selecting 
Compare in the Action menu or clicking on . Use the name of the application for the log 
file to make it easier to identify it later. You can now view all the changes made to your 
system by the installation in the View Log File tabs.

4. Now for the fun part: Run the ASHAMPOO shipped with the application you have just 
installed and try to remove the application from your system with it.

5. Then reboot and select Compare or  again to generate another log file. This will show you
all the components of the application that the application's ASHAMPOO failed to remove. If 
there's not much left it was a good ASHAMPOO. Usually, however, you'll find that it has left 
behind an amazing number of files and registry entries. You can now use ASHAMPOO 99 
DELUXE to remove these components as well.

Cool, isn't it?



The Two Program Windows

ASHAMPOO 99 DELUXE has two main screens, which are selected with the top two tabs on 
the left of the program window.

I: Selection: Registry, Drives This is where you select items that you want ASHAMPOO to 
monitor (see Selecting). This tab has the following sub-tabs:

Registry -- The contents of the Windows registry (see The Windows Registry)
Drives -- All the drives installed in your computer with their directory trees and file 

structures.
System Files -- Includes both initialization files win.ini and system.ini, and start-up files 

like config.sys and autoexec.bat (see User-defined System Files)
Options / Icons -- The list of files to be excluded from monitoring (see Preferences) and

the meanings of the icons is shown here

To select a branch (key) just click in the check box to the left of an entry in the tree display. If the
checkbox is grayed it means that at least one subkey is selected, but not all of them.

II: View Log File  -- This tab displays the changes found by Compare and recorded in the log 
file. It is divided into three sub-tabs that correspond to the sub-tabs in the Selection: tab (see 
above).

To restore branches or individual items right-click on the corresponding entry and select 
Restore Changes in the pop-up menu. You can restore individual items in the right-hand 
window or branches or the entire tree in the left-hand window using this method. 



The Windows Registry

Ever since the introduction of Windows(R) 95 all configuration information previously stored in 
separate INI files has been centralized in the Windows "registry", which is a central database 
managed by Windows. In principle it's a good idea but it is also a source of new problems. 
Every application can write its own data to the registry, and often this means that your registry 
gradually fills up with data "garbage", particularly if you often try out programs and then remove 
them from your system. 

The progressive growth of your registry slows down your system and wastes disk space. And 
since Windows always loads the entire registry into memory it also wastes your valuable RAM 
resources. For all these reasons, it's very important to make sure that all registry entries created
by applications are deleted again when the programs are removed from your computer.

Many applications have their own deinstallers. Unfortunately, most of these are of the "quick and
dirty" kind that leave a lot of garbage behind. If you want you can test this for yourself with the 
help of ASHAMPOO, then you'll understand what I mean!

There's no space here for a really thorough discussion of the registry. If you want to know more 
get a good book on Windows. Leading computer magazines like PC Magazine and Byte also 
frequently publish excellent basic articles on the registry and registry issues.

Note:
You don't have to monitor the keys in the HKEY_Current_User section if you are already 
monitoring HKEY_Users because the first section is a subset of the second.

Similarly, you don't have to monitor HKEY_Classes_Root separately because it is a subset of 
HKEY_Local_machine. 



Toolbar Commands

The toolbar contains the following icons for quick access to ASHAMPOO 99 DELUXE functions:

Wizard. Starts the Wizard that guides you through all of ASHAMPOO's main functions.

Load Selection File. Loads a ASHAMPOO 99 DELUXE selection (*.ECS) file. These are files 
stored by the user containing sets of all the selections made in the Selection: Registry, Drives 
tabs. (see Selection Issues for additional details).

Save Selection File. Saves your current Selection: Registry, Drives selections in an *.ECS 
file so that you can retrieve it later (see Selection issues for additional details).

Notes: 
Loading an installation log file (see Load Log File below) automatically overwrites your current 
selections with the ones used to generate the log file. This enables you to check the selections 
used to generate the differences between the configuration before and after an application was 
installed. If you want to preserve the current selection you should thus always save it to an 
*.ECS file before loading a log file!

When you exit ASHAMPOO 99 DELUXE the program automatically asks you if you want to 
save your current selections as the default for the next program start. If you select Yes the 
selection settings are saved in the file LAST.ECS, which is overwritten automatically every time 
you select this function.

Load Log File. Loads a log file containing the results of a comparison. This is the file generated
when you choose Compare after installing a new application. The file has the name you gave it 
when you performed the compare -- this will normally be the name of the application. It contains 
all the information ASHAMPOO needs to remove the application and restore your system 
configuration to its previous status.

Notes: 
Loading a log file overwrites the current selections with the selections used to perform the 
comparison. This enables you to check the selections used to generate the log file. If you want 
to preserve the current selections you should thus save them to an *.ECS file before loading the
log file.

Save Current Configuration      Writes the current configuration to the file OldCfg.ECD 
(automatically). Please always execute this function before installing new applications! This 
information is essential for determining the changes made to your system by the installation of 
the application. (NOTE: You don't need to execute this function when you use the Incremental 
Compare function .)



Compare      Saves the current configuration to NewCfg.ECD (automatically), compares it with 
the previoius configuration (OldCfg.ECD) and writes the results to a log file. You will be 
prompted to enter a name for the log file -- it is usually advisable to use the name of the 
application you have just installed so that you can find it easily if you decide to remove the 
application later.

Incremental Compare      This is almost the same as Compare. The only difference is that 
NewCfg.ECD is automatically renamed to OldCfg.ECD after the comparison is performed. This 
means that you don't have to store the current configuration again the next time you want to 
install an application. This feature is particularly useful when you are installing several 
applications at the same time. Please remember to perform a separate compare and write a 
separate log file after every installation so that you can remove the individual applications later. 
If you only do a single compare after installing all the applications you can only remove all of 
them together!

Refresh View      Refreshes and updates the contents of ASHAMPOO's windows. This function 
is also executed automatically every time ASHAMPOO is started so that you can see any new 
folders and registry keys and select them if necessary.

Notes: 
New children of selected or grayed parent folders and keys are monitored automatically; you 
don't need to select them explicitly.

Refresh View only refreshes folders and keys. To update the list of drives please select Reset 
Selections in the File menu.

Restore All      This is ASHAMPOO's "one-click deinstallation" option. Selecting this function 
restores all changes and restores the system to its previous state. This includes all changes to 
the registry, the file system and your system files. An information window will be displayed 
allowing you to confirm the operation before proceeding. If you're not sure select Cancel to 
abort.

You can get the same results by right-clicking on the root entry in all the View Log File tab 
windows and selecting everything.

WARNING: Using this function carelessly can be very risky! It may delete files that you still need
or restore values to the registry that can cause problems or trouble. Never use Restore All 
unless you are really sure that you know what you're doing. You have been warned!

To undo the changes made by the installation of an application or other modifications to your 
system and revert to the previous system status just right-click on an item in one of the View 
Log File tabs and select Restore Changes (works both in the tree view and list view windows). 
See Getting Started for further details.



 Step-by-Step Wizard      Starts the Step-by-Step Wizard that guides you through the 
individual steps of ASHAMPOO's main functions.

These two tools provide direct access to the wizards that guide you through the installation and 
removal of software applications. They are part of the new, two-button concept implemented in 
ASHAMPOO 99 DELUXE (see Quick Two-Button Operation for details).



Troubleshooting and Support

Problems can be caused by damaged or corrupt config and log files.

If something doesn't seem to be working right the first thing to do is reset the selection list by 
selecting Reset Selections in the File menu. If this doesn't help then delete (or rename) the 
following files manually:

LAST.ECS (current selection file)
OLDCFG.ECD 
NEWCFG.ECD (configuration files)

Then restart the program.

If you need more help you can contact us via e-mail at the following address:

support@Hilchner.de



User-defined System Files

ASHAMPOO 99 DELUXE allows you to add user-defined files to the default list in the System 
Files tab, which normally contains WIN.INI, SYSTEM.INI, CONFIG.SYS and AUTOEXEC.BAT.

To add a file right-click in the System Files tab as shown above to display the pop-up menu and 
select Add User-defined File. A dialog is then displayed with which you can add a text file like 
autoexec.bat or an INI file like win.ini.

INI files must have the following standard syntax: 

[Section 1]
Entry1=Value1
Entry2=Value2
...
[Section 2]
Entry1=Value1
Entry2=Value
...

ASHAMPOO 99 DELUXE will handle files conforming to this format in the same way as win.ini, 
even allowing you to select and deselect individual entries. The screenshot above shows the file
control.ini added to the System Files list.



What About Applications' Own Deinstallers?

Most modern applications ship with their own uninstall routines. You'd think that when the chips 
are down, these routines would provide the best removal performance -- after all, the application
programmers should know better than anyone else exactly where all the components of their 
applications are stored.

Unfortunately, this isn't true! In 90% of all cases the uninstall script is generated during 
installation by the installation program. The problem with this approach is that many settings are
not generated by the installation routine but by the application itself. None of these changes can
be registered by the uninstall routine, and thus lots of "garbage" gets left on your system when 
you use it to remove the application. 

A program like ASHAMPOO 99 DELUXE that registers all changes, including those made by the
application itself, can provide much better removal performance than these automated 
deinstallers.

This is also why we recommend that you should always run new applications at least once 
before creating the installation log with ASHAMPOO 99 DELUXE! See Running Applications 
after Installation for details.




